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QUANTIFYING POLLEN DEPOSITION WITH MACRO PHOTOGRAPHY AND 

‘STIGMAGRAPHS’ 
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Abstract—The pollen deposited during a single visit by a flower visitor (“single-visit deposition”; SVD) is often 
measured by removing the stigma from the flower and counting the pollen grains deposited under a microscope. 
This process precludes study of any subsequent interactions between the flower and later visitors (such as pollen 
removal from the stigma). Furthermore, if the stigma is excised too soon after the pollinator visit, the flower may be 
rendered infertile, such that any analyses of fruit or seed yield in relation to pollen deposition must be done 
indirectly. Here, a method of pollen deposition measurement was developed using macro photography and the 
open-source image-analysis software program ImageJ/Fiji. Using colour segmentation options within the program, 
the pollen grains can be distinguished from the background stigmatic surface, and the percentage of stigma coverage 
can be calculated. This pollen deposition measurement method leaves the sampled flower in the field to develop into 
fruit, allowing any subsequent yield or quality analyses to be conducted directly.  
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INTRODUCTION 

Experiments in pollination ecology often require a 
measure of the amount of pollen deposited onto a flower’s 
stigma. A measure of pollen deposition is required in order 
to compare pollen-transfer and pollen-deposition efficiencies 
among different species of flower visitors (Schemske & 
Horvitz 1984; Motten et al. 1981; Javorek et al. 2002; 
Adler & Irwin 2006; Garibaldi et al. 2013) or simply to 
distinguish between flower visitors and true pollinators 
(King et al. 2013). Pollen deposition measurements are also 
used when assessing the influence of pollen quantity on fruit 
and seed set in wild and agricultural plants (Falque et al. 
1995; Waites & Ågren 2004; Ne’eman et al. 2010).  

It is difficult to measure the pollen load on a flower’s 
stigma due to the small size of most stigmas, the vast number 
of pollen grains that can be deposited, and the potential to 
dislodge pollen during the measurement process. Further, 
because of the three-dimensional nature of many stigmas, 
pollen can be deposited in several focal planes, making the 
grains difficult to count (Flanagan et al. 2009). A widely 
used technique to determine the pollen load on floral stigmas 
is the stigma squash method (Kearns & Inouye 1993, Dafni 
et al. 2005, section 3.10). The stigma squash relies on a 
visual count of the pollen grains on a flower’s stigma under a 
microscope. Counting pollen on a squashed stigma can be a 
time-consuming process, and subsampling is often required 
when thousands of pollen grains have been deposited on a 

single stigma. A stigma squash also requires the flower’s 
stigma to be removed from the field. If a flower’s stigma is 
removed too soon, i.e. prior to pollen-tube growth and ovule 
fertilization, analyses of seed or fruit production by the same 
flower are not possible (Faegri & Van der Pijl 1979; Kearns 
& Inouye 1993). Lastly, a flower is usually visited by 
multiple pollinators, and pollen counts determined through a 
stigma squash cannot determine each individual species’ 
contribution to the total stigmatic pollen load.  

The purpose of the present study was to develop a 
pollen-deposition measurement technique that could be used 
to accurately quantify pollen deposition on stigmas, partition 
the stigmatic pollen load by pollen vector, and allow the 
sampled flower to remain in the field to develop fruit and 
seed. These particular criteria were chosen as they are 
important for research in pollination ecology and for studies 
relating pollination to fruit and seed development. Image 
analysis methods have successfully been used to count the 
number of pollen grains within flower anthers and on 
stigmas in a laboratory setting (Costa & Yang 2009; 
MacIvor et al. 2013), but had not been tested on flower 
stigmas that are to remain in the field. The ‘stigmagraph’ 
method of pollen deposition measurement developed here 
uses macro photography and image-analysis software to 
measure pollen deposition in situ. A stigmagraph is a 
photograph of a flower’s stigma, taken in the field and 
subsequently analyzed to determine the pollen count. Two 
species of daffodil (Narcissus pseudonarcissus and Narcissus 
nanus) were used to test and compare the stigmagraph 
technique to the standard stigma-squash technique. Pumpkin 
(Cucurbita pepo L.) flowers were used to determine if 
individual pollen grains on larger stigmas could be counted 
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using the stigmagraph method. Pollen deposition was also 
quantified on strawberry stigmas (Fragaria × ananassa) using 
the stigmagraph technique and compared to the seed set of 
the developed fruit. 

MATERIALS AND METHODS 

Stigma photography 

First, a photo is taken of the virgin stigma of the sample 
flower before any flower visits have taken place. This is done 
to determine the baseline amount of pollen (if any) 
deposited on the stigma prior to any flower visits, and to 
accurately determine the amount of pollen deposited by each 
visitor thereafter. A photograph (hereafter a ‘stigmagraph’) 
of the sample flower’s stigma(s) is then taken after each 
flower visit. Each stigmagraph needs to be taken at the same 
angle, lighting, and camera aperture setting to ensure 
consistency for image analysis. For a stigmagraph to be 
adequate for image analysis, it must be taken with a camera 
fitted with a dedicated, macro lens (at least 1:1 
magnification). The type of lens used will depend on the size 
of the stigmas of the sample flower and the working distance 
required. A standard macro lens, such as a Canon EF 100 
mm macro lens, is adequate for flowers with a pistil surface 
of greater than 2 mm in diameter. Macro photography 
inherently involves working with a very shallow depth-of-
field (DOF). To achieve the largest depth-of-field possible, 
the photos should be taken with a small aperture opening 
(f/16). Photographs taken further away from the flower will 
increase DOF but sacrifice image detail. This is undesirable 
for the subsequent photo analysis and detection of pollen 
grains. If the stigmatic surface is not flat, as is often the case, 
it is best to capture a series of images of the stigma surfaces 
at increasing focal depths. Focus stacking, or focal plane 
merging, can then be performed on the images at the 
processing stage (Johnson 2008).  

Once the photos of the stigma(s) are captured in the 
field, the photos are processed through ImageJ/Fiji to 
determine the amount of pollen deposited on the stigma. 
ImageJ is a free, Java-based image-processing program and 
Fiji is an open-source image-processing package which 
operates within the ImageJ software environment (Schneider 
et al. 2012; Schindelin et al. 2012). For flowers with simple 
morphology, such as the single-pistiled daffodil (Narcissus 
spp.), pollen grains can be distinguished from the 
background stigmatic surface using the segmentation options 
within ImageJ, namely colour thresholding. Two Narcissus 
spp. were used here to test the stigmagraph method with two 
different-sized pollen grains, and because they were readily 
available in the field. 

 Photographs of several pumpkin (Cucurbita pepo L.) 
stigmas were taken after a series of flower visits to determine 
if the number of pollen grains deposited on larger stigmas 
could be counted in a set of focus-stacked photos using the 
Fiji Cell Counter plugin. By adjusting the camera angles, the 
full extent of the stigmatic surface can be captured, but this 
requires time and manipulation of floral structures. As such, 
the pumpkin stigmas were only photographed from the top 

down; the underside of the stigmas was not captured in the 
stigmagraphs. 

For more complex flowers, such as the multi-pistiled 
strawberry (Fragaria spp.), the Trainable Weka 
Segmentation application (Hall et al. 2009) is more suitable 
to determine the total stigmatic pollen load. Alternatively, on 
a flower with multiple pistils, the number of stigmas carrying 
pollen can be counted from the photographs using Cell 
Counter. This is the simplest option for a researcher 
requiring a measure of the number of stigmas having received 
pollen. Strawberry was chosen as a test flower because of the 
multi-pistiled morphology and the ability to assess successful 
pollination from the outside of the fruit. The three photo-
processing options used to calculate the proportion of the 
stigmatic surface covered by pollen—ImageJ Colour 
Thresholding, the Trainable Weka Segmentation and 
manual counting with Fiji’s Cell Counter—are described in 
detail below.  

Measuring pollen deposition with ImageJ Colour 
Thresholding  

The proportion of the stigmatic surface covered by 
pollen can be calculated using ImageJ Colour Thresholding 
(ICT) as follows: 

1. Open the image of the virgin stigma in Fiji. Convert the 
image to a RGB colour photograph under ‘Image’ in the 
Type menu.  

2. To remove the background, use the ‘Adjust colour 
threshold’ option under the Image>Adjust menu. Select the 
‘Dark background’ option to fill the stigmatic surface in 
black (Fig. 1A). Click the ‘Select’ button, and close the 
Colour Threshold Window. Then select ‘Clear outside’ 
under the Edit menu. This will remove the background and 
leave only the stigmatic surface in the photo. Select ‘Binary’ 
under the Process menu and select ‘Make binary’. This will 
create an image similar to Fig. 1A. 

3. Select ‘Histogram’ under the Process menu and then 
select ‘List’. This will open a table of values. The first 
column of the table contains a list of colour values; the 
second column contains the area of each colour, in pixels. 
The area corresponding to colour-value 255 (black) is the 
area of the stigmatic surface.  

Note: To measure the pollen deposition in terms of 
proportion of stigmatic area, a scale is not needed. If a 
measurement of pollen deposited in mm2 or cm2 is desired, a 
scale can be set under the Analyze menu. Only measurements 
of the proportion of the stigma surface covered in pollen are 
described here. 

4. Open the next image of the sample stigma, taken after 
the flower has received a visit. Repeat step 1, and use the 
‘Adjust colour threshold’ option under the Image>Adjust 
menu and de-select the ‘Dark background option’. Then 
click ‘Select’ and close the Colour Threshold Window. Then 
select ‘Clear’ (not ‘Clear Outside’) under the Edit menu. 

5. Open the Colour Threshold Window. Move the sliders 
on the ‘Hue’, ‘Saturation’, and ‘Brightness’ options  
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FIGURE 1. Quantifying the amount of pollen in the stigma 
photographs (stigmagraphs) with ImageJ Colour Thresholding 
(ICT) A) Binary photo of a virgin daffodil stigma (Narcissus 
pseudonarcissus). B) The same stigma with background removed. 
C) The segmented photograph, with pollen grains selected using 
colour thresholding. D) The binary photo of pollen deposition 
used to create a histogram and quantify the proportion of the 
stigmatic surface covered by pollen. 

until only the pollen is highlighted in red. This effectively 
allows only those colours associated with pollen to pass and 
thus segments the photo into pollen and non-pollen areas 
(Fig. 1C).  

6. Select ‘Binary’ under the Process menu and select ‘Make 
binary’. This will create an image similar to Fig. 1D. Select 
‘Histogram’ under the Process menu and then select ‘List’. 
This will open a table of values. The value next to 255 
(black) in the table is the area in pixels of the stigmatic 
surface covered by pollen. 

7. Divide the number of black pixels obtained in Step 6 by 
the number of pixels obtained in Step 3 to obtain the 
proportion of the stigma covered by pollen. 

Measuring pollen deposition with Trainable Weka 
Segmentation  

For flowers of more complex morphology, the 
proportion of the stigmatic surface covered by pollen can be 
calculated using the Trainable Weka Segmentation (TWS) 
application, as follows: 

1. TWS is a tool built into the Fiji version of ImageJ which 
can be accessed through the ‘Segmentation’ option in the 
Plugins menu. 

2. Once in the TWS environment, zoom in on the 
stigmagraph(s) as much as possible. Use the Freehand 
selection tool to manually select areas of the photograph that 
contain pollen and pick ‘Add to Class 1.’ Once 2 or more 
areas clearly containing pollen are selected, select areas that 
do not contain pollen and add them to ‘Class 2’. Then click 
Train classifier. This trains the application to define colours 
in Class 1 pixels as pollen, and Class 2 pixels as non-pollen 
(Fig. 2A).  

3. Once the classifier training is finished (this can take a 
while, depending on computational power), select Create 
result in the left-hand menu. This will create an output 
similar to Fig. 2B.  

4. Convert the image to binary (Fig. 2C) and obtain a 
histogram of colour values, as described in Step 6 of the 
ImageJ Colour Thresholding section (above). The amount of 
pollen in the photo is the number of black pixels indicated in 
the histogram table.  

Measuring pollen deposition with Cell Counter 

The Fiji Cell Counter can be used to count and track 
particles or objects in an image. Cell Counter can be used to 
count stigmas containing pollen as follows: 

1. Select the Cell Counter plug-in under Plugins in the 
Analyze menu. 

2. Initialize the photo by clicking the initialize button in 
the Cell Counter window. 

3. Rename Type 1 and Type 2 to “Pollen” and “No 
Pollen”, respectively (Fig. 3B). 

4. Select Type 1 and use the Arrow tool to click on the 
stigmas that contain pollen grains. 

 



16 MACINNIS & FORREST J Poll Ecol 20(2) 

 

 

FIGURE 2. Section of macro photograph of strawberry 
(Fragaria × ananassa) stigmas and several anthers after processing 
through the Trainable Weka Segmentation (TWS) application in 
ImageJ. A) The TWS training window; red lines are the 
classification selections for pollen (circled in black), and green lines 
are the classification selections for non-pollen (circled in red). B) 
The output of the TWS. The orange areas indicate sections 
classified as pollen. C) The binary image used for the total pollen 
deposition calculation. 

5. Select Type 2 and use the Arrow tool to click on the 
stigmas that do not contain pollen grains. 

6. Select Results to obtain a table containing the number of 
stigmas with and without pollen. 

Comparing the stigmagraph method to the 
stigma-squash method 

To test the ICT and the TWS measurements against the 
standard stigma-squash technique, 11 flowers of Narcissus 

pseudonarcissus and 11 flowers of Narcissus nanus were 
hand-pollinated by lightly touching a dehiscing Narcissus 
anther to each stigma. The stigmas were then removed and 
photographed. In each photo, the proportion of the stigma 
covered in pollen was determined (in pixels) by both ICT 
and TWS. This proportional area of pollen on the stigma 
surfaces was then divided by the surface area of one 
Narcissus pollen grain to estimate the number of pollen 
grains on the stigma. The ICT method was performed twice 
on each stigma - once by an experienced stigmagrapher and 
once by an observer new to the stigmagraph method, in order 
to compare the processing time between users. The TWS 
measurement was only conducted once due to limited 
computational power. The time it took to process each 
stigmagraph with ICT was recorded for 12 stigmagraphs (6 
N. nanus and 6 N. pseudonarcissus). The timing of the ICT 
method began when the photos were transferred to the 
computer and open in ImageJ, and ended when the user 
determined the number of pollen grains on the stigma. 

Once photo processing was completed, the stigmas were 
squashed on microscope slides with fuchsin-stained gelatin. 
The pollen grains were counted on each stigma at 400 × 
magnification once by each observer, without sub-sampling. 
For 12 stigma-squash slides (6 N. nanus and 6 
N.pseudonarcissus), the time required to complete the pollen 
counts on the stigma squash was recorded for each observer. 
The stigma-squash timing began once the stigma was 
mounted on the slide and ready to be counted.  

Comparing stigmagraph pollen counts to seed set 

In the spring of 2015, 120 commercial strawberry plants 
(Fragaria × ananassa, “Jewel” variety) were haphazardly 
selected at the McGill Horticultural Research Farm, 
Montreal, QC (45°24'39.6" N, 73°56'12.2" W) for a 
comparison of the number of stigmas containing pollen, as 
calculated using stigmagraphs, and seed set. A strawberry 
flower contains many carpels, each of which contains one 
ovary and one ovule. Once successful fertilization occurs, the 
ovaries of the strawberry flower develop into one-seeded 
achenes. Hereafter, seed set refers to the number of fertilized 
achenes per strawberry. The development of achenes is what 
stimulates the growth of the edible tissue of the receptacle 
(Nitsch 1950). Thus, the weight and shape of the berry is 
directly related to the number of achenes on a strawberry, 
which largely depends on the number of ovules successfully 
fertilized through pollination.  

The selected strawberry plants were covered with cotton 
mesh at the bud stage and one primary flower of each plant 
was labelled. Once flowers were open, the mesh was removed 
to allow pollinators to visit and the flowers were 
photographed after each pollinator visit. To vary the 
quantity of pollen deposited, flowers were exposed to a 
varying number of pollinator visits (1–10); mesh was then 
replaced over the flowers. The strawberry variety used in this 
study was protogynous and the sampled flowers were not 
emasculated, so the flower stigmas were also photographed 
two days later to capture changes in the pollen load due to 
autogamous pollen deposition. After all photographs had 
been taken, the strawberry plants were kept covered until the 
stigmas began to turn brown and the petals had abscised.
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FIGURE 4: Fertilized and unfertilized achenes of a sampled 
strawberry. Fertilized achenes are those with a diameter > 0.4 mm 
and unfertilized achenes are those with diameter ≤ 0.4mm.  

 

The total number of stigmas with pollen (including any 
autogamously deposited pollen) was calculated using the Fiji 
Cell Counter on the stigmagraphs taken at the end of 
receptivity, as described above. Once the fruit had developed, 
each strawberry was harvested and cut in half, and each side 
was photographed to avoid double-counting any achenes. 
Achene diameters were determined from the berry photos 
using the ImageJ Measure function. As in Ariza et al. (2010), 
any achene ≤ 0.4 mm in diameter was considered 
unfertilized (Fig. 4). Fertilized achenes were counted using 
Fiji’s Cell Counter.  

Data analysis 

The differences in pollen counts between the stigma-
squash and stigmagraph methods were normally distributed, 
so paired t-tests were used to compare the pollen load of the 
daffodil stigmas as determined by each stigmagraph analysis 
method (ICT and TWS) and the pollen load determined 
using the stigma-squash method. The pollen counts for each 
observer were first analysed separately; i.e., the ICT pollen 
counts done by one observer were compared to the stigma-
squash counts of the same observer; we then compared the 
two methods using the pooled data from both observers. 
The pooled data were log-transformed to meet the 
assumption of multivariate normality and the relationship 
between stigmagraph pollen counts and stigma-squash pollen 
counts were assessed through SMA regression. The TWS 
was only done once by the experienced observer and was not 
included in the pooled analysis. The timed ICT counts and 
stigma-squash counts of each observer were compared using 
paired t-tests. 

The relationship between strawberry seed set and 
number of pollen-bearing stigmas (as determined by Cell 
Counter) was modelled with simple linear regression. The 
number of fertilized achenes was expected to be less than or 
equal to the number of stigmas bearing pollen. A paired t-
test was used to compare the number of pollen-bearing 
stigmas to the number of seeds per strawberry. 

FIGURE 3. Counting stigmas containing pollen grains with Cell 
Counter in Fiji. A) Strawberry (Fragaria × ananassa) stigmas with 
pollen (blue) and without pollen (green) selected using the Cell 
Counter tool. B) The Cell Counter menu. 
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TABLE 1: Comparison of the pollen counts determined by the stigmagraph processing methods and the pollen counts on the 
stigma squash slides for an experienced and an inexperienced observer. A positive mean difference indicates that the first method listed 
estimated a higher number of grains than the second method. 

Observer Compared methods Mean difference t df P 

Experienced ICT vs. Stigma squash 0.7% 0.61 21 0.55 
Inexperienced ICT vs. Stigma squash 4.0% 1.96 21 0.06 
Experienced TWS vs. Stigma squash 2.1% 1.07 21 0.30 
Both (pooled) ICT vs. Stigma squash 2.3% 1.93 43 0.06 

 

RESULTS 

The average time to process a photo of a daffodil stigma 
with ImageJ Colour Thresholding (ICT) and determine the 
pollen load was 11.7 ± 4.4 minutes (mean ± s.d.) for an 
experienced stigmagrapher. The average time for the same 
individual to count the daffodil pollen grains on a squashed 
stigma was not significantly different, at 11.9 ± 3.6 minutes 
(t = 0.17, d.f. = 11, P = 0.89). The average time for an 
individual new to the stigmagraph technique to photograph a 
stigma and process the photo was 20.2 ± 7.1 minutes, vs. 
only 13.42 ± 4.79 minutes for a stigma-squash pollen count 
(t = 4.45, d.f. = 11, P < 0.001). Thus, the inexperienced 
observer took significantly longer than the experienced 
observer to process a stigmagraph with ICT (t = 2.96, d.f. = 
11, P = 0.01), whereas there was no significant difference in 
stigma-squash counting time between observers (t = 0.73, 
d.f. = 11, P = 0.24). The average time to count pollen-
bearing stigmas on a strawberry flower with Cell counter 
stigmagraph was 5.8 ± 2.1 minutes. The Cell counter 
procedure was only conducted by one observer. 

 

FIGURE 5. The relationship between the number of pollen 
grains determined by the ICT method in stigmagraphs and the 
number of pollen grains determined by stigma squashes for two 
species of daffodil (N. pseudonarcissus and N. nanus). The SMA 
regression line (solid) has slope = 0.93 ± 0.09, i.e. not significantly 
different from 1, and intercept = 0.18 ± 0.3, i.e. not significantly 
different from 0. The dotted line is the 1:1 line. N = 44 
observations of 22 stigmas; R2 = 0.88. 

The stigmagraph and stigma-squash methods yielded 
similar stigmatic pollen counts (Tab. 1, Fig. 5). The ICT 
method tended to estimate a higher number of pollen grains 
per stigma than the stigma-squash method for both 
observers, but this difference was non-significant for the 
experienced observer and only marginally significant for the 
inexperienced observer (Tab. 1). The inexperienced 
observer’s ICT pollen counts were, on average, significantly 
higher than those of the experienced observer (Tab. 1).  

The relationship between the pollen deposited and seed 
set for strawberry was analysed for 95 flowers; 25 berries 
were lost before harvest. There was a positive linear 
relationship between the number of stigmas pollinated on 
strawberry flowers and the number of seeds produced by 
those flowers (Fig. 6). The number of seeds per flower was 
not significantly different from the number of pollen-bearing 
stigmas, as determined by Cell Counter (t = 1.11, d.f. = 94, 
P = 0.27), but 44% of the flowers had fewer pollen-bearing 
stigmas than developed seeds.  

For the stigmagraph test of the large stigmas of pumpkin 
flowers, the pollen grains were easily recognizable in the 
stigmagraph (Figure 7A) and readily counted using Fiji’s Cell 

 

Figure 6. The relationship between number of seeds per 
flower and number of pollen-bearing stigmas as calculated by 
stigmagraphs for commercial strawberries (Fragaria × ananassa). 
The OLS regression line (solid) has slope = 0.92 ± 0.15, i.e. not 
significantly different from 1, and intercept = 9.25 ± 26.2, i.e. not 
significantly different from 0. The dotted line is the 1:1 line. N = 
95 flowers; R2 = 0.61. 
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FIGURE 7. Counting pollen on larger stigmas with 
stigmagraphs. A) A focus-stacked stigmagraph of the multi-lobed 
stigma of a pumpkin flower (Cucurbita pepo L.). B) A section of 
the stigmatic surface with the individual pollen grains counted using 
Fiji’s Cell counter. 

Counter (Figure 7B). Although the photographing time was 
not recorded, it takes more time to photograph the entire 
surface a large, multi-lobed stigma like that of pumpkin, than 
smaller or less-complex stigmas. 

DISCUSSION 

The stigmagraph method produces stigmatic pollen 
deposition measurements similar to those of the traditional 
stigma-squash method. The stigmagraph method does not 
necessarily reduce pollen-counting time compared to the 
stigma-squash method, but this new method is certainly a 
feasible way to determine pollen load when preparing a 
stigma squash is not possible—for instance, if stigmas are 
too large (e.g., Cucurbitaceae spp., Lilium spp.) or too 
numerous (e.g., Fragaria spp.). Pollen grains on large stigmas 
can be counted individually by taking a series of photographs 
focused throughout the depth of the stigmas. The underside 
or obstructed sections of a stigma can be captured by 

adjusting the camera angle or removing the petals. However, 
manipulating floral structures may affect the behaviour of 
flower visitors and the problem of capturing pollen grains 
that are completely masked by other grains will remain 
regardless of camera angle. Further testing of the 
stigmagraph method is needed to test the accuracy of this 
pollen-counting technique for stigmas with various degrees 
of complexity. The stigmagraph method may prove capable 
of quantifying pollen deposition on flowers of many other 
plant families, such as Cactaceae, Iridaceae, or in orchids 
lacking pollinia (e.g. Cypripedium spp.). 

The time required to process a stigmagraph and the 
accuracy of the pollen count is highly dependent upon user 
experience. Once a user gains experience with the ImageJ 
software environment, the time it takes to calculate pollen 
load can be less than that of a stigma squash, especially if the 
stigma contains a large number of grains. The accuracy of 
the stigmagraph method depends on the observer’s ability to 
capture focused, high-resolution photographs of the sample 
flowers, which requires some practice. If the image contains 
aberrations due to the camera flash or light reflections, it is 
harder to correctly distinguish pollen from background 
surfaces during image processing. The ‘Remove outliers’ 
function is one option within ImageJ that can be used to 
reduce reflection effects (see Ferreira & Rasband 2012), but 
it is preferable to avoid image irregularities at the photo 
capture stage. Once the photography portion is mastered, 
this method is quick and suitable for field situations. 

The accuracy of the stigmagraph method also depends 
on the user’s ability to correctly define what constitutes 
pollen on the photos of the stigmas. This subjectivity 
introduces the potential for measurement bias, and for 
within- and between-observer variation in pollen counts. 
This subjectivity can be reduced by using the TWS tool, but 
if the illumination varies across stigmagraphs, pollen can be 
erroneously selected by the TWS as well. However, there is 
no reason to believe that error associated with the 
stigmagraph method would be more than that of the stigma-
squash method, as the stigma squash involves manually 
counting pollen grains under a microscope, subsampling, or 
using similar image analysis software to determine pollen 
loads. 

A problem with both the stigmagraph and stigma-squash 
methods is that pollen grains often clump together and can 
be deposited in several layers. Only the topmost layer of 
pollen can be seen in a stigmagraph. Squashing a stigma may 
redistribute the grains in a more uniform plane, but there can 
often still be a great deal of pollen clumping on a stigma-
squash slide. Surprisingly, the pollen load determined on the 
daffodil stigmagraphs here was usually higher than that of 
the pollen counts on the stigma squashes. This discrepancy 
was most likely due to some non-pollen image aberrations 
being classified as pollen by the ICT. It was noticed that the 
reflection of light in the secreting papillae of some of the 
daffodil flowers was often classified as pollen by the ICT 
and the TWS methods. This was corrected for in most of 
the ICT and TWS iterations done by the experienced 
observer, but not by the inexperienced observer for the ICT 
counts.  
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A 1:1 relationship was expected between the number of 
pollen-bearing stigmas and the seed set of strawberry, but 
some variation is to be expected due to post-pollination 
processes such as ovule abortion. Although seed set is largely 
dependent on successful pollen deposition, the viability and 
successful germination of the deposited pollen can be 

affected by climate and environmental factors (Žebrowska 
1995; Ledesma & Sugiyama 2005). Florivorous insects can 
also damage reproductive organs post pollination (Howitt et 
al. 1965; Ariza et al. 2012). These factors may explain some 
of the variation in the number of stigmas pollinated versus 
seed set, as western flower thrips (Frankliniella occidentalis) 
and tarnished plant bugs (Lygus lineolaris) were observed on 
the sampled flowers. However, the intercept of the regression 
of seed set on pollen-bearing stigmas was positive, indicating 
that more seeds were produced than would be expected 
based on pollen deposition (at least at low levels of pollen 
deposition). The higher number of seeds than pollen was 
most likely due to autogamous pollen that was deposited 
after the stigmagraphs were taken, as strawberry is self-
compatible and the stigmas can remain receptive for 3-7 days 
(McGregor, 1976). The flowers were not emasculated and 
final stigmagraphs were taken two days after the flower visits, 
so it can be assumed that the anthers of some of the sampled 
flowers still contained pollen. 

There are several other limitations to consider when 
attempting to use the stigmagraph method for pollen 
deposition measurement, namely, the colour of the pollen 
grains, the size of the stigmas, and computational power. 
Segmenting the photos can be difficult (and sometimes 
impossible) when the colour of the pollen is similar to the 
colour of the stigmatic surface. It can take a great deal of 
adjusting and readjusting to reach the correct threshold 
values using ICT (described above). The TWS readjusts 
automatically but it requires time to train the classifier on 
complex photos. The photos needed for this method are 
intrinsically large and the time required to complete the 
TWS on an image is highly dependent on computational 
power. It is recommended that 16 gigabytes or more of 
memory be dedicated to ImageJ to hasten photo processing. 
Several test stigmagraphs should be taken and processed to 
ensure that pollen can be distinguished from the background 
of the stigma prior to using this method for research 
purposes. 

The stigmagraph method is currently not suitable for 
flowers with tiny reproductive structures. It was not possible 
with the camera lens used in this study (Canon© EF 100 
mm macro) to obtain images suitable for analysis of very 
small stigmatic surfaces. The smallest stigmas successfully 
tested here were those of commercial strawberry, which are 
approximately 0.8 mm in diameter. Further testing with 
lenses of higher magnification capabilities is required to 
determine if the stigmagraph method can be used to measure 
pollen deposition on minuscule stigmas. It is presently more 
advisable to use the traditional stigma squash technique to 
determine the pollen load on stigmas smaller than 0.8 mm. 
For stigmas of larger size and depth, it would be necessary to 
use a focus-stacked set of photos to capture the majority of 
the stigmatic surface. Focus-stacking requires more time at 
each flower in the field but does not add much time to the 

image-processing stage. Fiji and ImageJ are well equipped to 
deal with photo stacks (see Ferreira & Rasband 2012). 
Lastly, the stigmagraph method partitions the pollen 
deposited by the colour of the pollen grains. If many 
different co-flowering plant species are present in an area, a 
stigmagraph cannot discern the species identity of the 
deposited pollen grains, or whether or not the deposited 
pollen is viable.  

Nonetheless, the stigmagraph method is a viable means 
of measuring stigma pollen load and was successfully used 
here to obtain pollen counts similar to those of the stigma 
squash method. Most notably, the stigmagraph method 
allows the sampled flower to remain in the field without 
manipulation to develop into fruit and seed. This enables a 
direct comparison of pollinator performance to fruit and 
seed set, without manipulating the sampled flower. Further, 
measurements of the pollen deposited by multiple successive 
flower visitors can be obtained using this technique, allowing 
the determination of each species’ contribution to the 
stigmatic pollen load. The stigmagraph method also has the 
potential to track the location of pollen placement on flower 
stigmas, and the rate of pollen removal from stigmatic 
surfaces, especially in flowers with larger stigmas and pollen 
grains. Thus, this new method of pollen deposition 
measurement has strong potential to advance the field of 
pollination ecology. 
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